
Welcome
Welcome to Mozzle Domain Name Pro
Practical Internet Web Designer Edition

Special Upgrade Offer!

Use the special promotional code printed in the magazine to take advantage of the special upgrade 
offer. To upgrade select Upgrade Now from the Upgrade menu in Domain Name Pro.

Upgrading Domain Name Pro

The latest version of Domain Name Pro contains these additional features not found in the Practical 
Internet Web Designer edition:

· Website link popularity search in 9 major search engines and Yahoo and DMOZ directories.
· Word terms search to find popular keywords and domain names.
· Domain name website competition ratings.
· Domain name effectiveness index (TM) to rate domain name value.
· Automatic popular alternative domain names.
· An additional 400,000 terms in the search term popularity database.
· Display the type of domain name generated in searches.
· Pause and resume searches.
· Multiple domain name display formats.
· Play a sound when a search is finished.
· Generate and search up to 20,000 domain names.
· Color-coded domains list.
· and more!

First Steps

NOTE: Please consult the System Requirements, particularly Win95 users who see the message "Error 
on loading Winsock2 library".

Before using Domain Name Pro for the first time you should read the Configuration section to ensure that 
Domain Name Pro is set up correctly for your connection to the Internet. If you are new to using Domain 
Name Pro then you should read the Overview and Getting Started sections to become familiar with how 
Domain Name Pro works.

Latest Information

The latest Domain Name Pro news is announced via the in-built Mozzle News tool.

See also:
System Requirements
Configuration Overview
Domain Name Pro Overview
Getting Started





Using Online Help
To use the online help you do not need to be connected to the Internet, however in some places you are 
given the opportunity to browse to a web page on the Internet via web links.To use them you will need to 
be connected to the Internet. Topic links allow you to quickly jump to a related topic found elsewhere.

Domain Name Pro uses contect sensitive help. This means that you can select an item within Domain 
Name Pro, such as a search term or option, and simply press the F1 key to view help for that particular 
item.

The help file is organized into related chapters. You can also search for particular help topics using the 
index, or search for topics from the Find tab.



Additional Downloads
Additional Downloads

When first started, and by default every 7 days thereafter, Domain Name Pro will automatically run the 
update wizard to check for updates to the domains list and the Domain Name Pro program itself. Program
updates must be manually downloaded and installed from the Get Update link provided in the updates 
wizard. Data file updates are downloaded and installed automatically by the wizard. The update wizard 
can be run manually at any time by selecting Check For Updates from the Tools menu. Updates will also 
be announced in the Mozzle News tool, accessible from within Domain Name Pro by selecting Mozzle 
News from the Tools menu or by clicking the Mozzle News icon  on the main toolbar.

Some additional Domain Name Pro downloads are available from the Mozzle web site at:
http://www.mozzle.com/download/

PDF Manual

The online help distributed with Domain Name Pro is also available as a professional 89-page PDF 
manual, complete with contents, hyperlinks, page thumbnails, and an index. The manual can be read 
elecronically or printed to produce a hardcopy manual. Note: The manual applies to the latest version of 
Domain Name Pro and therefore some features mentioned do not apply to this Domain Name Pro edition.

See also:
Check For Updates



System Requirements
Windows Updates

Domain Name Pro uses a network connection to the Internet to get domain name details and link 
popularity and to check domain name availability. There are known network problems with several 
versions of Windows which may affect the operation of Domain Name Pro. We recommend that you 
install the following Windows updates, particularly for Windows 95 and Windows 98/98SE, which are 
available for download from the Microsoft web site. If you are using Domain Name Pro and experience 
frequent "error" domain name results or stability problems then it is important that you install the Windows
updates. Note: You should back up important files before installing any Windows update.

Windows 95
Required: Windows Socket 2 Update. Download from:
http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/
w95sockets2/default.asp
Highly Recommended: Windows 95 Service Pack 1.

Windows 98 and Windows 98 SE
Recommended: The latest Windows 98/98SE service pack.

Windows NT4 Workstation
The latest Windows NT Workstation service pack (currently SP6a).

Windows NT4 Server
The latest Windows NT Server service pack (currently SP6a).

Windows 2000
The latest Windows 2000 service pack (currently SP3).

Windows XP
The latest Windows XP service pack (currently SP1).

General System Requirements

Domain Name Pro has the following minimum system requirements:

· Pentium II 266 CPU (or equivalent).
· Windows 95/98/ME/NT4+/2000/XP.
· 64 MB RAM.
· 20 MB disk space for the installed program.
· A connection to the Internet.

Note: Domain Name Pro can use a large amount of RAM when performing searches with many results. 
Approximately 27MB of RAM is used upon startup and an additional 4MB is used for each 1000 search 
results. Despite this Domain Name Pro should run on a PC with only 32MB RAM, albeit quite slowly.

We recommend the following system specifications:

· 128 MB RAM.
· A fast connection to the Internet (56Kbps or higher).
· A minimum screen resolution of 800 x 600.



Overview
What Is Mozzle Domain Name Pro

Mozzle Domain Name Pro is an advanced tool for finding the ULTIMATE popular web site domain names.
With the ever growing popularity of the Internet, companies, organizations, and individuals are creating 
web sites for all kinds of purposes including business details, product and service information, and special
interests. There are tens of millions of web site domain names registered and as time goes on it becomes
increasingly difficult to find a good domain name that is not already registered. Domain Name Pro is an 
advanced domain name tool which solves this problem.

Use Domain Name Pro to:
· Check if a specific domain name is available.
· Find popular available and registered domain names.
· Search for expiring domain names.
· Develop a great name for your product, service, company, business, production, or organization.
· Find good keywords to use on your web page (use the searches without selecting a domain to check 

and keyword popularity will be checked).

Four Great Searches

Domain Name Pro allows you to find great domain names using the following searches.

Upgrade Note: The latest version of Domain Name Pro contains two additional searches, Word Terms
search to find popular alternative domain names and keywords, and Link Popularity to check website 
link popularity in major search engines and directory listing status in Yahoo and DMOZ. Upgrade Domain 
Name Pro.

Simple Search
Simple automatic combinations of the words that you enter. For example:

top digital cameras
This will generate the domain names top, digital, cameras, topdigital, topcameras, digitalcameras, and 
topdigitalcameras.
The domain names are checked in all domains selected from the domains list.

Advanced Search
Advanced specific combinations of words using separate word alternatives lists that you define. Individual
position, optional/mandatory, and thesaurus alternatives settings can be specified for each group. For 
example:
Group A - Optional, Position: Start

fresh
green
wholesome
organic

Group B - Mandatory, Position: Middle/End
food
groceries
shopping

Group C - Optional, Position: End
store
business
market
shop

This will generate the domain names food, groceries, shopping, freshfood, greenfood, wholesomefood, 
organicfood, freshgroceries..., foodstore, ..., freshfoodstore...
The domain names are checked in all domains selected from the domains list.



Pattern Search
Specific character-level domain name generation supporting 6 wildcard characters and optional and 
alternative parts. For example:

[e/i](-)[book/mag/magazine](s)
This will generate the domain names ebook, ibook, emag, imag, emagazine, imagazine, e-book, ..., 
ebooks..., e-books...

zApN
This will generate the domain names zap0, zep0, zip0, zop0, zup0, zap1, zep1...
The domain names are checked in all domains selected from the domains list.

Details Search
Display the domain name whois (registration) information for a list of full or unqualified domain names or 
URL's. For example:

microsoft.com
http://www.internet.com
apple

This will retrieve the domain name whois details for the domain names microsoft.com and internet.com.
Any domain names which do not include the domain (such as apple above) will be checked in all domains
selected from the domains list.

Smart Domain Name Generation

The built-in word thesaurus/lexicon will generate up to hundreds of similar domain names automatically. 
For example, when you enter the word "business" Domain Name Pro can automatically check domain 
names with related words such as "company", "office", "work", "market", "industry", and "project". You are 
not restricted to using basic pre-defined word lists to use as a prefix/suffix to the domain name as 
provided in other tools (though Domain Name Pro offers this facility as well). Automatic search features 
such as Net Speak™, Acronyms and Hyphens will also generate ingenious domain names with ease.

Upgrade Note: Additionally, by using a custom search engine database of the top 100,000 search terms 
from a list of more than 4 million, the latest version of Domain Name Pro can automatically generate 
popular alternative domain names. Upgrade to the latest version

What is a Domain Name

A domain name is the main part of a web address (also known as a universal resource location or URL for
short), such as mozzle.com and is quite like a "named" unique Internet address. It determines the overall
name of the web site and is therefore the single most important thing that your 
customers/readers/listeners need to remember about your web site. The domain name also determines 
the end part of all email addresses used with the web site, such as info@mozzle.com. The domain name
appears in ALL references to the web site.

The overall structure of a simple web URL is:

<protocol>://<sub-domain>.<domain name>/<web page>

eg. http://www.mozzle.com/downloads.htm

So http is the protocol, www is the sub-domain, mozzle.com is the domain name, and downloads.htm 
is the web page. This is a simplified explanation of the structure of web addresses. Note that http is the 
default protocol and www the default sub-domain in most browsers so they do not normally need to be 
entered when browsing to a particular web site: mozzle.com is sufficient.



See also:
Simple Search
Advanced Search
Pattern Search
Detail Search
Do You Have Any Tips For Domain Names?



Getting Started
First Time Setup

The first step to using Domain Name Pro is to configure the firewall and proxy settings and search 
performance relevant for your Internet connection. This only needs to be done once. See the 
Configuration section for more details and then return here.

How to Use Domain Name Pro

Domain Name Pro includes four searches: A simple word search, an advanced word search, an advanced
pattern (character) search, and a detail search. You should familiarise yourself with each and choose the 
appropriate search to use. For a quick overview on these searches see the Domain Name Pro Overview. 
For detailed information select one of the searches listed here.

The general procedure for the simple, advanced, and pattern search is outlined in the following steps:

1. Select the domains that you need to check, for example .com and .co.uk.
2. Select the search that you would like to use (simple, advanced, pattern), by clicking the appropriate 

tab heading in the centre of the Domain Name Pro window.
3. Enter or load the search terms, for example a list of key and add-on words for the desired domain 

name, or a pattern term.
4. Set any search specific options, such as the number of thesaurus alternatives, or the position of the 

words in the domain name.
5. Set any general search options, such as how hyphens will be used, whether to use Net Speak™ or 

Acronyms, or set limits for the generated domain names.
6. Press the Search button. Domain Name Pro will generate the domain names and check their 

availability.
7. Sort, filter, print, register, browse or export the results.

Upgrade Note: The latest version of Domain Name Pro also allows you to pause and resume searches. 
Upgrade Domain Name Pro.

See also:
User Interface Overview
Configuration Overview
Searching Overview
Simple Search Overview
Advanced Search Overview
Pattern Search Overview
Detail Search Overview





User Interface Overview
Domain Name Pro contains a compact user interface to arrange the relevant options in a useful manner 
and to allow people with small and large monitors alike to use Domain Name Pro. The user interface 
comprises the following sections from top to bottom:

· Main Menu
· Toolbar
· Search Options
· Search Results
· Status Bar

Several options are available through context sensitive right-click popup menus. In most instances 
keyboard shortcuts can be used to access the Domain Name Pro features.

Main Menu
The main menu provides convenient access to the major features of Domain Name Pro, such as loading 
and saving word lists or patterns, exporting search results, printing, text editing operations, Domain Name
Pro program options, access to online help, Mozzle News, and information about the version of Domain 
Name Pro being used. Select the appropriate menu item to perform the required function. Note that most 
menu options are disabled during a search.

Toolbar
The toolbar, present just below the main menu, provides quick access to printing, text editing, Mozzle 
News, and online help functions. Additionally, the Search and Stop buttons are located on the toolbar and
are used to start and stop a domain name search respectively. Simply click the appropriate button. During
a search the Search button changes to Pause. When paused the button changes to Resume. An 
animated icon moves when a search is in progress. Note that most toolbar options are disabled during a 
search.



Search Options
The search settings occupy the centre portion of the Domain Name Pro window. They consist of a 
domains list, searches, and general search options.

Search Results
The results of searches are displayed in the bottom portion of the window. The simple, advanced, and 
pattern searches display the domain name search results in a table format. The details search displays 
the results in a text format.

Status Bar
The status bar displays the progress and statistics of the current search in progress, and the status of 
results filtering. If a filter on the results is currently active the words "Filter Applied" appear in the status 
bar.

Popup Menus
Several context sensitive popup menus are available when using Domain Name Pro. Note that most 
popup menu options are disabled during a search. The popup menus are as follows.

Domain List
· Load domain selections. 
· Save domain selections. 
· Clear all selected domains.

Simple, Advanced, Pattern, and Details Search Terms
· Load a word list or pattern. 
· Save the current word list or pattern. 
· Text editing operations such as Copy, Cut and Paste.

Simple, Advanced, and Pattern search Results Table
Note that the results table popup menu items change according to the item which is right-clicked. For 
example, right-clicking on the available status for a domain name will present options applicable to 
available domain names.
· Register an available domain name. 
· Browse to the web site of a registered domain name. 
· Perform a trademark search on the domain name (several options).
· Display the domain name details.
· Add the registered domain name to the link popularity search term. 
· Copy the domain name results to the clipboard (several options).
· Export the results table to a file. 
· Filter the results.
· Print preview of the results table. 
· Print the results table. 

Details View for a Selected Domain Name
· Display the results table. 
· Save the domain name details. 

Keyboard Shortcuts



In addition to the common text editing keyboard shortcuts, such as ctrl-c for copy or ctrl-v for paste, 
Domain Name Pro includes many alt-key shortcuts. Alt-key shortcuts are denoted by an underline 
character in the various menu items and options displayed. Some examples are:

· alt-s Search! 
· alt-a Advanced search. 
· alt-o Popular alternatives 
· alt-k Net speak words 
· alt-r All results 

See also:
Searching Overview
Domain Name Search Results Table



Domain Name Search Results Table Overview
The domain name search results from the simple, advanced and pattern searches are presented in a 
table in an easy-to-read format.

Each domain name generated in the search is listed once only on a new row, and each domain selected 
from the domains list is displayed in a separate column across the top. This makes it very easy to read 
the domain names checked, to look for a particular name available in any domain, or to look for any name
available in a particular domain.

To scroll the results table automatically as each domain name is generated see Display Options.

Results Table Columns

Several columns are displayed in the results table. These are:

· No. - The order in which the domain names are generated and searched.
· Domain Name - The generated domain names.
· Search Pop. - A calculated search engine popularity rating which gives some indication of how often 

terms in the domain name are searched in the major search engines. This column is optional and can 
be disabled in the display options.

· Domains - One column is displayed in the results table for each domain name selected in the domains 
list. The status of the domain name in each domain is shown in each row.

· Checked - The date and time when the domain name was generated and checked.

Upgrade Note: The latest version of Domain Name Pro contains additional features that are displayed in 
the search results, such as the type of domain name generated (normal, thesaurus alternative, popular 
search term alternative, acronym, NetSpeak(TM)), a website competition rating (how many web sites 
contain the words in the domain name) and domain name effectiveness index(TM). Upgrade Domain 
Name Pro.

As each domain name is being searched the message checking... is displayed until the domain name 
status is retrieved from the domain name servers.

When the search is complete you can use the right-click popup menu in the results table to:
· Register available domain names.
· Browse to the web site of registered domain names.
· Perform a trademark search on the domain name or words in the domain name.
· Filter the results to hide results that you are not interested in.
· Sort the results by any column (such as popularity rating or availability in a particular domain).
· Copy the results to the clipboard for pasting into another application such as a spreadsheet or email 

message.
· Export the results to a text, CSV (comma delimited), or HTML file.



· Print the results to a printer or fax.
· View the whois details for a particular domain name / domain.

Note that some rows in the results table may be hidden if a filter is applied.

See also:
Simple Search Overview
Advanced Search Overview
Pattern Search Overview



Search Engine Popularity Ratings
Domain Name Pro includes a database of the top 100,000 search terms and their frequency from a list of 
over 4 million terms. Using this database Domain Name Pro can calculate an indicative search engine 
popularity rating for each domain name generated. This rating indicates how often people search for the 
words in the domain name in major search engines.

Upgrade Note: The latest version of Domain Name Pro contains an additional 400,000 search terms. 
This provides popularity ratings for a greater number of domain names, allowing you to use the full 
potential of this feature. Upgrade Domain Name Pro.

The Search Pop. column can be shown or hidden from the display options.

The higher the popularity rating the more popular that the words in the domain name are searched in the 
major search engines. The following table is a guide as to how the ratings relate to actual popularity.

Rating Popularity
20 or higher Very high
5 to 20 High
1 to 5 Moderate
0.2 to 1 Low
Below 0.2 Very low

Domain Name Pro can optionally add a weighted score for sub-lists of words in the domain name to the 
overall popularity rating. This option is available from the search options. Take the following words in a 
domain name for example:

mobile phone accessory

With the sub-lists option disabled the popularity rating would be calculated for "mobile phone accessory" 
only. With this option enabled the popularity rating would be calculated for "mobile phone accessory", and
to a lesser extent for "mobile phone" and "phone accessory", and to a much lesser extent for "mobile", 
"phone" and "accessory". The rationale for this is that people searching for "mobile" would be much less 
likely to find your web site than people searching for "mobile phone accessory".

See also:
Display Options
Search Options



Domain Name Status Types
The following table describes the various search results shown for each domain name.

checking... Mozzle is currently checking the availability status of this domain 
name.

Available!     or
Available!

The domain is available for you to register. If this is shown as 
Available! (an underlined web hyperlink) you can register the domain
name directly from Mozzle Pro. Click the domain name status to go 
to the domain name registration page using your default web 
browser.

registered The domain name is already registered. You can browse to the web 
site for this domain name from the popup menu.

exp: YYYY-MM-DD
exp: N days ago
exp: In N days

The domain name is registered and expires on the date or number of
days shown. The expiry information is shown instead of the 
"registered" status if the domain names expiry date is within the 
number of days configured in the search options. Note: Not all 
domain names have expiry date information.

reserved The domain name is reserved and cannot be registered. Some 
domains do not allow registration of generic or common domain 
names such as "internet" or "home".

unknown The domain name search result neither indicated that the domain 
name is available or registered. This can be caused by a domain 
name server limiting the number of domain name checks in a given 
period of time and returning a response to indicate this. See the FAQ
for more details.

skipped The domain name is too short for this domain. Many domains have 
restrictions on their minimum length. For example .info and .biz 
domain names must have a minimum of 3 characters.

error The domain name check failed. This can be caused by a faulty 
Internet connection or problems with a particular domain name 
server. See the FAQ for more details.

cancelled All unchecked domain names are marked as cancelled when the 
Stop button is clicked to cancel a search.

eval This is displayed for all domains except .org and .net in the 21-day 
limited trial of Mozzle Pro until unregistered. To remove this 
restriction and see the true domain name results of all domains you 
need to register Mozzle Pro.



Mozzle News
What is Mozzle News?

Domain Name Pro includes automatic web-linked product news headlines. This contains announcements 
and links to information such as:

· Important and general Domain Name Pro news and announcements of upgrades for download. 
· Current international domain name news headlines. 
· Links to updated information on the Mozzle web site, such as frequently asked questions. 
· General Backslash news. 

Configuring Mozzle News 
Domain Name Pro can automatically check for new headlines periodically. See the Configuring News & 
Updates section for configuration details.

Reading Mozzle News

If you have automatic news checking enabled the Mozzle News reader will automatically be displayed 
after the configured number of days when Domain Name Pro is started. If automatic news checking is not 
enabled you can select Mozzle News from the Tools menu or click the Mozzle News button  on the 
main toolbar to display the news reader.

News items are shown in categories in a tree-view style. Double click a category heading or click its +/- 
symbol to expand and collapse the categories.

Most news items are linked to a web page. If the news item is displayed as a web link when the mouse is 
placed over it you can simply click the headline to browse to the linked web page in your default browser.



Old news items are marked with the hollow symbol 
New news items are marked with the colored symbol .

See also:
Configuring News & Updates



Check For Updates
From time to time changes are made to the domains list and Domain Name Pro program itself. Changes 
include adding new domains, updating server information, adding new features, or fixing bugs. It is 
recommended that you use the latest changes.

Configuring Automatic Checks 
Domain Name Pro includes an update wizard which can be used to check for program and data file 
updates. Program updates must then be downloaded and installed manually, however data file updates 
can be downloaded and installed automatically by the wizard.

The updates wizard can be configured to appear periodically when Domain Name Pro is started. By 
default it is configured to appear the first time that Domain Name Pro is run and then every 7 days. See 
the Configuring News & Updates section for configuration details.

Running the Updates Wizard

If you have automatic update checking enabled the Updates Wizard will automatically be displayed after 
the configured number of days when Domain Name Pro is started. If automatic checking is not enabled 
you can run the Updates Wizard manually by selecting Check For Updates from the Tools menu.

The Updates Wizard will appear and take you through a series of steps to check if newer versions of the 
program and data files are available by contacting the mozzle.com web site.

Note: You must be connected to the Internet to check for updates.

Welcome
Use the Next button to step through the updates process:

Check for Updates
The update wizard will check for program and data file updates and summarise these in step 2 "Check for
Updates". If the program and all data files are up to date you can finish and close the wizard. If updates 
are available select Next to continue the update process.

Get Program Update
You can upgrade to the latest version of Domain Name Pro at any time. Click the Get Update link to go to 



the special upgrade offer.

Get Data File Updates
Data file updates are downloaded and installed automatically by the wizard, however you must restart 
Domain Name Pro to use them as they are loaded when Domain Name Pro is started. The download and 
installation progress is displayed in the wizard.

Note: This step is skipped if there are no data file updates available.

Finished
A summary of the update actions taken is displayed. You can then close the wizard to return to Domain 
Name Pro. Don't forget to restart Domain Name Pro if data file updates were installed.

See also:
Configuring News & Updates



Configuration Overview
Domain Name Pro can be configured in several ways. These include search performance,    firewall and 
proxy server configuration, automatic mozzle news and updates, display options, and search options.

To configure Domain Name Pro select Options from the Tools menu or click on the Options button  on 
the main toolbar.

Important: If you use a firewall or proxy server you must configure this before stepping through the 
update wizard or performing searches.

See also:
Search Performance
Firewall and Proxy Settings
Updates
Display Options
Search Options



Search Performance
The search performance is set via the program options dialog, accessible from the Options menu or by 
clicking the Options button  on the main toolbar. The search performance affects the number of 
simultaneous domain name availability checks to perform during simple, advanced, and pattern searches.
The higher the number the faster the search. For convenience several pre-defined options are available 
to match your Internet connection speed.

The speed at which Domain Name Pro can search for domain name availability is dependent on factors 
such as the speed of the domain name servers for the domain(s) you are searching and your 
geographical distance from the domain name servers, however the most important factor is the bandwidth
(speed) of your connection to the Internet.

On a 56Kbps modem connection you can achieve search speeds of up to 20 domain name checks per 
second. Domain Name Pro has the potential to search several times more than this with faster Internet 
connections. Using a multi-threaded search engine, each check is independent of the others, therefore 
many checks can be performed simultaneously.

Set the search performance according to your Internet connection speed. If you are unsure of this then 
read your modem manual, ask your Internet Service Provider, or ask your companies network 
administrator. If you are sharing the Internet connection with others then please be mindful of this and set 
the performance to a lower setting. You should also be mindful of the fact that searches place a high load 
on the domain name servers, and in order to facilitate a good service to all users you should not exceed 
the recommended settings. It is better to search multiple separate domains (such as .com, .info, 
and .co.uk) at the same time, as this will help to spread the load.

You can also enter a custom search performance. Due to the additional workload that higher settings 
have on your PC and on the domain name servers, this value has been limited to a maximum of 60.

TIP! Each competition rating search engine selected requires an additional live lookup for each domain 
name in domain name searches and therefore each search engine selected will slow down the 
search. Select just one or two search engines or uncheck the web site competition rating and 
domain name effectiveness index™ columns in the display options to increase domain name 
search performance.

See also:
Firewall and Proxy Settings
Display Options



Firewall and Proxy Settings
SOCKS Firewall-Proxy Configuration

A firewall/proxy is an application or dedicated server that can control information originating from and 
going to the Internet, and can be used to protect unauthorized access to the network. Firewalls/proxies 
are often used by companies that have a medium to large computer network connected to the Internet. 
Domain name searches and possibly the Mozzle News will be affected by the SOCKS firewall-proxy 
options.

If you connect to the Internet through a firewall then you should configure the SOCKS firewall-proxy 
settings. They are set via the program options dialog, accessible from the Options menu or by clicking the
Application Options button  on the main toolbar.

Enter the configuration information applicable to your firewall (ask your Network Administrator if you are 
unsure). Your firewall may or may not require the User ID and Password to be entered. If HTTP (web 
browser) data must also be sent through the SOCKS firewall then you should select Use SOCKS for 
HTTP. This option will effect the Mozzle News.

If you are having difficulty getting the domain name searches to work through your firewall double check 
that the settings are correct. Try using the minimum number of options: Use SOCKS firewall/proxy, set the
SOCKS version (4, 4A or 5), Address and Port. Try the other SOCKS versions, and also try with and 
without the User ID and/or Password. The Port is normally 1080 but may be different in your network.

HTTP Proxy Options

A HTTP proxy is an application or dedicated server through which all HTTP (web browser) data must be 
sent. It controls information originating from and going to the Internet, and can be used to protect 
unauthorized access to the network. HTTP proxies are often used by companies that have a medium to 
large computer network connected to the Internet.

HTTP data is used by several features of Domain Name Pro:



· Mozzle News
· Updates Wizard

If you use a HTTP proxy then you should configure the HTTP Proxy settings. They are set via the 
program options dialog, accessible from the Options menu or by clicking the Application Options button 
on the main toolbar.

Enter the configuration information applicable to your HTTP proxy (ask your Network Administrator if you 
are unsure). Your HTTP proxy may or may not require the User ID and Password to be entered. If you 
also connect to the Internet through a SOCKS firewall-proxy and HTTP (web browser) data must also be 
sent through it then you should select Use SOCKS for HTTP in the SOCKS Firewall-Proxy Options.

If you are having difficulty getting the Mozzle News to work through your HTTP proxy double check that 
the settings are correct. Try using the minimum number of options: Use HTTP proxy, set the Address and 
Port. Try with and without the User ID and/or Password. The Port is normally in the 8000 range but may 
be different in your network.

See also:
Search Performance



Display Options
The display options are set via the program options dialog, accessible from the Tools menu or by clicking 
the Application Options button  on the main toolbar.

Display Tooltip Hints

Tooltip (popup) hints are provided for all visible controls, displaying a short help message on what each 
control does. Simply pause the mouse cursor over the control to display the tooltip hint. Tooltip hints can 
be invaluable when you are first learning to use Domain Name Pro, however they can become annoying 
once you are familiar with the various settings and features.

Scroll With Results

When this option is checked the domain name search and link popularity search results table will 
automatically scroll to the end as the search progresses. This "follow" option allows you to see the current
searches that Domain Name Pro is performing.

Results Grid Columns

You can select which optional columns are displayed in the domain name search results table. This allows
you to view columns to see informative information about each domain name or to hide columns to 
conserve space in the table. The optional columns are:

· Search popularity rating

Upgrade Note: Additional columns can be displayed in the latest version of Domain Name Pro. 
Upgrade Domain Name Pro.

Display Expiry Dates of Registered Domain Names

This option enables you to see the expiry date of domain names that have expired or are about to expire, 



instead of the generic "registered" status. You can display the expiry date of a registered domain name in 
the simple, word terms, advanced and pattern searches. The expiry date will be shown if it is within the 
configured number of days in the future or past.

You can choose to show expired/expiring domain names with the expiry date or the number of days from 
the current date.

See also:
Search Engine Popularity Ratings
Domain Name Search Results Table



Search Options
The search options are set via the program options dialog, accessible from the Tools menu or by clicking 
the Application Options button  on the main toolbar.

Save Search Settings

When you enable this option, the general search settings are saved when Domain Name Pro is closed. 
The next time that you start Domain Name Pro the search settings that you last used will be selected. The
search settings saved include:

· Domain selections. 
· The search selected. 
· For the simple search: Max. thesaurus/word alternatives, Use all words, Keep approximate order. 
· For the advanced search: word group Positions, Optional/Mandatory status and number of 

thesaurus Alternatives.
· General settings: Hyphens, Net Speak™, Acronyms, limits set for Max. words, Max. length, All 

results/Max. results. 

Save search settings is enabled by default.

Two-Level Search

Some domains require a two-level lookup (two separate searches) to retrieve the full whois details for the 
domain names. If you need to view the full whois details for domain names then select this option. Note 
that when this option is enabled the search for some domains will be slower.

Include Sub-lists of Words in Popularity Rating Calculation

The search popularity rating is based on the popularity of search terms in the domain name on the major 
search engines. Domain Name Pro can optionally add a weighted score for sub-lists of words in the 
domain name to the overall search popularity rating. See search engine popularity ratings for more 



information.



Configuring News & Updates
The settings for configuring Mozzle News updates or Program and Data File Updates can be found on the
Updates tab of the options dialog, which is accessible from the Tools menu or by clicking the Application 
Options button  on the toolbar.

Configuring Mozzle News Updates 
By default Domain Name Pro will automatically check for news updates every 7 days, when the Domain 
Name Pro news reader appears when Domain Name Pro is started.

Automatic checking can be disabled. You can still manually check for and read news from the Help, 
Mozzle News menu item. When automatic checking is enabled you can set the number of days between 
automatic checks.

Configuring Program and Data File Updates 
By default Domain Name Pro will automatically run the Updates Wizard to check for program, domains 
list, link popularity list and competition rating list updates every 7 days when Domain Name Pro is started.

Automatic checking can be disabled. You can still manually check for updates by selecting Check For 
Updates from the Tools menu. When automatic checking is enabled you can set the number of days 
between automatic checks.

See also:
Reading Mozzle News
Cheking For Updates



Searching Overview
Searching

Which Search?

Deciding which search you should use depends on what you are trying to achieve. The following table 
lists the searches and their uses.

Search When To Use How to Use
Simple · For quick searches.

· To generate all combinations of 
the words entered.

· If you are a new Domain Name 
Pro user.

· Enter several separate words, 
select the domains, hit search.

Advanced · For advanced control over word 
combinations.

· If you are an regular Domain 
Name Pro user.

· Enter groups of related words, 
set advanced word group 
options, select the domains, hit
search.

Pattern · For exact domain name 
generation on a character-by-
character basis.

· To find any short domain names.
· If you are an experienced 

Domain Name Pro user.

· Devise the base of the domain 
name, add optional and 
alternate parts, add wildcard 
characters, select the domains,
hit search.

Detail · If you want to extract contact 
details for potential web sites to 
purchase.

· To save details about a 
registered domain name that is 
for sale.

· Enter a list of domain names, 
copy them from a previous 
simple/word 
terms/advanced/pattern search
results, or copy and paste a list
of web link shortcuts or URLs, 
then select the domains if 
required, and hit search.

Upgrade Note: The latest version of Domain Name Pro contains two additional searches: Word Terms
Search to enter a list of pre-defined domain names and to find popular domain names and keywords, and
Link Popularity Search to check website link popularity in major search engines and directory listing 
status in Yahoo and DMOZ. Upgrade Domain Name Pro.

Starting a Search
Searching starts when you select domains, enter valid search terms, and press the Search! button. The 
domain names are displayed and searched automatically.

Some general recommendations for domain name search terms are:

· Select just a few keywords that are most relevant to the domain name that you want. For example, your
service or product name, company name, or the words in an ideal domain name that you may have 
thought of.

· Include a few descriptive add-on words that supplement the domain name should the exact domain 
name that you want be unavailable. For example, a few verbs (action words) or adjectives (describing 
words) such as running, dynamic, or fast.

TIP! For the best results the simple, word terms, and advanced search terms that you enter should 
consist of separate words for the domain name. This allows Domain Name Pro to use the automatic
thesaurus to find similar domain names, and enables better use of the search popularity rating, Net 
Speak™, hyphens, and other search options. To enter separate words in the search term simply 



separate them with spaces or put one word on each line.

Pausing, Resuming and Stopping a Search
Once a search has begun you can pause or stop it at any time. The Search button changes to a Pause 
button during a search and then to a Resume button when the search is paused. When a search is 
paused any current domain names being searched will be completed but no new domain names will be 
searched until the search is resumed. When a search is manually stopped (cancelled) any current 
searches are aborted and the status "cancelled" is displayed in the results.

If too many domain names are being generated for your search you can reduce the number of thesaurus 
alternatives, enter less words in the search terms, use less wildcards in the pattern search, or set limits 
for the results.

How Domain Names Are Generated

The closest matching domain names are checked first. The simplest domain names using the exact 
search terms entered are checked first, then Domain Name Pro progressively generates more complex 
domain names by adding additional optional words in the domain name and incorporating thesaurus 
alternatives.

The simple and advanced searches generate domain names using the following priority order:

· All combinations of one word domain names first, then two words and so on until the maximum number 
of words is reached. 

· All combinations with no thesaurus alternatives first, then with one alternative, two alternatives and so 
on. 

· All combinations without hyphens and then with hyphens.
· Acronyms are checked after the standard domain name. 
· Check the generated domain name as-is and then with Net Speak™.

The pattern search generates domain names using the following priority order:

· No optional parts, then each combination of one optional part, two optional parts and so on. 
· All combinations of alternative parts, starting with the first alternative part in each group, then rotating 

through alternative parts from the last one back. 
· All combinations of wildcard characters, starting with the first character for each wildcard, then rotating 

through characters from the last one back. 
· Check the generated domain name as-is and then with Net Speak™. 

Search Statistics

As the search progresses the total number of domain names checked, the number recognised as 
available, registered, reserved, and the number unknown and number of errors are displayed in the status
bar at the bottom of the window for your reference.

See also:
Simple Search
Advanced Search
Pattern Search
Detail Search



Selecting Domains
To search for the availability of domain names in the simple, advanced and pattern searches, and for 
domain names entered without a domain extension in the detail search, you must select one or more 
domains from the domains list at the left of the Domain Name Pro window. Simply check the box of each 
domain that you would like to check.

Domains List

Upgrade Note: In the latest version of Domain Name Pro the domains are color-coded as follows:

· Green for major global top-level domains (gTLDs).
· Yellow for other global top-level domains and popular unrestricted country-code top-level domains 

(ccTLDs).
· Blue for the special country-code .com domains.
· White/grey groupings for each country-code domains.

Upgrade Domain Name Pro.

TIP! If you perform a Simple, Advanced or Pattern search without selecting any domains then the 
domain names will still be generated (and you can copy them to the clipboard) without actually 
searching if those domain names are available. This is useful to test your search term prior to 
running a full availability check or for searching for popular domain names or web site keywords!

For some tips on what domains to select see the domain name tips section in the FAQ.

Saving and Loading Domain Selections

You can save the currently selected domains to load at a later time by selecting File, Save, Domain 
Selections from the main menu. Alternatively you can select Save Selections from the domain list popup 
menu. To load a previously saved list of domain selections select File, Load, Domain Selections from the 
main menu or select Load Selections from the domain list popup menu. Note that the current domain 
selections will be cleared prior to loading.

Clearing Domain Selections

You can manually clear the currently selected domains by pressing shift-del when the domains list is 
active or by selecting Clear Selections from the domain list popup menu.

Jumping to a Domain

To quickly jump to a particular domain simply click inside the domain list (so that it is active) and type the 
domain to jump to. For example, typing .au will jump to the first domain that includes the .au suffix. The 
search is incremental in that the search is more specific as each character is typed. If you make a mistake
simply pause for a few seconds and type the domain again.

Domains List Information

The number of domains currently available and the domain list version and date are displayed in the 
About box, accessible from the Help, About menu item.



Choosing Domains to Search

Generally you will only select a few of the generic unrestricted domains (shown at the top of the list) or a 
few domains for your region of the world based on the domain suffix (shown in alphabetical order below 
the generic unrestricted domains). For example, all .au domains (.com.au, .org.au and so on) are for 
Australia. All .uk domains (.co.uk, .org.uk and so on) are for the United Kingdom. There are usually 
restrictions on who can register domain names in these country-specific domains. Contact your local 
domain name registrar for details.

When important new domains are released they will be added to the list (provided a publicly accessible 
domain name database server is available for them). If you would like a particular domain to be added to 
the list then please contact us. We will add it to the list if domain name status information is publicly 
available for the domain.

Updates to the domains list are made available for free. Use the built-in Check For Updates or Mozzle 
News features to check and download them.



Using Thesaurus Alternatives
The built-in automatic word thesaurus (lexicon) in Domain Name Pro is invaluable for finding the ultimate 
domain name for your searches. As a simple example, when searching for "great bike" Domain Name Pro
can generate and search for similar domain names such as "top cycle" and "best ride" (and many other 
combinations).

The maximum number of thesaurus alternatives to use can be set in the simple search (as a whole) and 
in the advanced search individually for each word group. The options are None, or 1 to 10.

The automatic thesaurus contains over 110,000 alternatives to more than 11,000 root words, selected 
from the most commonly used words on the web. It is an excellent way to find the best and closest 
matching available domain names for you. For example, a simple search with the words "business help" 
and a selection of up to 3 alternate words (the default) will result in a search of 40 domain names 
including the following:

business
help
company
work
program
use
service
support
businesshelp
helpbusiness
businessuse
businessservice
businesssupport
companyhelp
workhelp
programhelp
...
supportprogram 

Note that the more words that you enter and the higher the number of alternatives selected, the more 
domain name combinations that are checked. A simple search of 3 words with 10 alternatives can 
produce more than 8,500 domain names! We recommend using an advanced search to isolate words that
should have few or no alternatives checked from those that should have a lot of alternatives checked. As 
Mozzle generates and checks domain names dynamically there is no great risk in having a large number 
of combinations. You can limit the number of results or stop the search whenever you feel that enough 
domain names have been checked.



General Search Options
The general search options appear to the right of the searches.

Domain Name Generation Options

Upgrade Note: The latest version of Domain Name Pro allows you to also select the number of automatic
popular alternative domain names to generate. For example, when checking the domain name with the
words "web design" it can automatically generate popular domain name alternatives such as "web site 
design", "web page design", "web design company", and "free web design". Upgrade Domain Name Pro.

Search Limits

See also:
Hyphens in Domain Names
Net Speak
Domain Name Acronyms
Limiting Results



Hyphens in Domain Names
This option can be found to the right of the main search in the general search options panel. It specifies 
how hyphens will be used in multi-word (or multi-part) domain names to join the words/parts. This option 
is only available for the simple and advanced searches.

Hyphens can be set to always, never, or optional (check with and without hyphens).

When set to optional, a simple search for "direct marketing" with no thesaurus alternatives would check 
the domain names:

directmarketing
direct-marketing
marketingdirect
marketing-direct 

Generally it is easier for people to remember and use domain names without hyphens and easier for you
to verbally communicate the domain name, however using hyphens gives you more flexibility to find the 
best available domain names. The default hyphen setting is Never.



Net Speak
The Net Speak™ option can be found to the right of the main search area in the general search options 
panel. It allows you to check snazzy alternative spellings of generated domain names by automatically 
substituting certain character sequences with similar sounding alternatives, to create words commonly 
used in electronic discussion forums.

Some typical Net Speak™ alternatives are shown in the following list (there are many more alternatives 
not shown here):

one 1
to, too, two 2
eight, ate 8
x ks
cs/ks x
cc x, ss, or k
qu kw, or k
c k
s z

Some examples of alternative domain names using Net Speak™ are as follows:

for kids 4kidz
quick pick kwikpik
its too late itz2l8
baroque music barokmusik
card tricks kardtrix
accident axident
accommodate akommod8

Net Speak™ is disabled by default.



Domain Name Acronyms
This option can be found to the right of the main search area in the general search options panel. It allows
you to automatically check acronyms for the generated domain names. An acronym is made up of the first
letter of each word/part in the generated domain name. For example, the generate domain name "linux 
users group" has the acronym "lug".

The acronym option is only available in the Simple and Advanced searches. Acronyms are disabled by 
default.

Note: Acronyms are not generated for popular alternative domain names.



Limiting Results

The generated domain names to search can be limited in several ways. The limits options can be found to
the right of the main search area in the general search options panel.

The results limiting options described in the following sections.

Number of Words

You can limit the number of words (or word parts) used in the generated domain names of the simple and 
advanced search using the Max. Words option. This option is also disabled if you select the Use all words
option in the Simple search.

Limiting the number of words in each domain name is particularly relevant when many words are entered 
for the simple search. In most cases long domain names are undesirable, and up to three words is 
generally appropriate.

The default limit is 5.

Character Length

You can limit the maximum length of the domain name, specified as the number of characters. This limits 
the name itself, and does not include the domain suffix (.com and so on). Long domain names are 
generally undesirable, as they are harder to remember and use. All domain names are limited to between 
2 and 64 characters. You can set any maximum length in this range.

The default limit is 60.

Number of Results

You can limit the number of domain names that will be generated and checked for the search. For 
example, setting this value to 50 will mean that a maximum of 50 domain names will be generated, and 
Mozzle will check each domain selected for each of these domain names.

Mozzle checks the closest matching domain names first. You will typically only need to look at the top of 
the results list for a good available domain name. Some searches, particularly when using many 
thesaurus alternatives or pattern wildcards, will generate a lot of domain names to check. Limit the 
number of results to an appropriate value.

The default limit is 500. A maximum limit of 1000 is imposed.



Registering Available Domain Names
You can register an available domain name directly from Domain Name Pro.

This option is available either by clicking a domain name for a particular domain that is marked as 
Available! (as an underlined web hyperlink) or by selecting Register from the popup menu for the results 
table. To display the popup menu right-click the appropriate result in the results table. You can also click 
on domains marked as Available! (as an underlined web hyperlink) in exported HTML results files to 
register them.

This option is available for almost 100 domains. The domain name registrars have been pre-set to 
provide the greatest number of domains that this is available for. The domain name registration page for 
the selected domain will appear in your default Internet browser. Simply follow the steps on the web site 
to register the domain name.

See also:
Browsing Web Sites of Registered Domain Names
Domain Name Search Results Table



Browsing Web Sites of Registered Domain Names
When the search results show that a domain name is not "Available", for example "registered" or 
"unknown", you can right-click the status to display the popup menu and select Browse to 
www.<domainname> or Browse to <domainname> (without the leading www).

Selecting either option will browse to the web page for the domain name using your default web browser. 
If a web site has not been set up for the domain name then your browser may display an error message 
that it could not find the requested web page. This is a normal response, as some people register domain 
names for use at a later date.

See also:
Registering Available Domain Names
Domain Name Search Results Table



Trademark Searching
US, UK and Canadian trademark searches are available for domain names shown in the results table. 
Simply right-click the domain name and select the appropriate trademark search option from the popup 
menu. The trademark search is performed online via trademark search web sites.

Two searches are available:

· String search. The entire domain name is searched as a single string/word. eg. "maximumspeed".
This is available in the simple, advanced and pattern search results. 

· Word search. The words that make up the domain name are used individually in the search. eg. 
"maximum speed". This is available in the simple and advanced search results only. 

Some trademark search services may treat both search types in the same manner. i.e. "maximumspeed" 
and "maximum speed" may return the same trademark search results.

Note: The results of these trademark searches are indicative only and should not be relied upon as the 
true trademark status. Consult a professional trademark search agency to perform a thorough search to 
confirm the trademark status.



Filtering Results
One a search is complete you can filter the results to display only those results that you are interested in. 
To set the results filter select Set Filter from the Edit menu or from the results popup menu.

You can filter the results on:

· Domain name availability (available, registered and so on). Select the availability status types that 
you wish to display and uncheck those that you wish to hide.

· Words in the domain names generated. You can use the * and ? wildcard characters to limit the 
domain names displayed to those containing the words that you enter. Place each filter term on a 
separate line. e.g. *net* will display only those domain names that contain the string "net", such as 
"netball" and "mynetwork".

· Popularity rating. Set the minimum and maximum popularity rating to display in the search results.

When a filter is applied the words "Filter Applied" appear in the status bar at the bottom of the Domain 
Name Pro window. Note that if a new search is performed the current filter is deactivated. The same filter 
can be turned on and off by toggling the Filter Applied item in the Edit menu or results table popup menu.

See also:
Sorting Results
Copying Results
Exporting Results
Printing Results



Sorting Results
Once a search is finished you can sort the results. Sorting results is achieved simply by clicking on any 
column heading in the results table. This allows you to sort the domain names alphabetically, by 
availability for a particular domain, or by popularity rating. To sort in reverse order simply click the same 
column heading twice. The sort indicator shows the direction of the sort.

You can perform a multiple column sort by clicking on the primary column heading first, then by shift-
clicking on secondary columns. The sort index order is shown in the column headings.

The sort indexes are cleared when a new search is performed.

TIP! To quickly find good available domain names first enabled the display of the search engine 
popularity rating and/or domain name effectiveness index from the display options. Perform a 
simple, advanced or pattern search. When a search is complete use column sorting as follows to 
show good available domain names at the top of the results grid:

1. Click the domain column heading (such as .info) to sort by availability.
2. Hold down the shift key and click twice in the Search Pop. column to sort by highest rating first.
3. Scroll to the top of the results grid. The good available domain names to register will be 

displayed first.

Upgrade Note: The latest version of Domain Name Pro also allows you to sort by domain name 
effectiveness index(TM), website competition ratings, and link popularity. Upgrade Domain Name 
Pro

See also:
Filtering Results
Copying Results
Exporting Results
Printing Results



Copying Results
When a search is complete you can copy the results to the clipboard for pasting into other applications, 
such as a word processor, email, or spreadsheet. Several copy options are available:

· All results
· All domain names (without the domain extensions).
· Available domain names (with the domain extensions).
· Registered domain names (with the domain extensions).
· The selected domain name. e.g. mydomain
· The selected domain name and domain. e.g. mydomain.com

Once the copy operation is selected you can switch to the other application and paste the copied data.

See also:
Filtering Results
Sorting Results
Exporting Results
Printing Results



Exporting Results
Once a search is complete, the results of the search (as displayed in the results table) can be exported 
(saved) to a file. The supported file formats are:

· Formatted text file. This uses fixed width columns to format the results neatly.
· CSV (comma separated) file for loading into a spreadsheet or database.
· Formatted HTML file.

To export the results select Export from the File menu or select Export from the results table popup menu.

See also:
Filtering Results
Sorting Results
Copying Results
Printing Results



Printing Results
When a search is finished you can print the domain name search results for presentation or later 
reference.

The page setup option, which can be selected from the File menu, allows you to set many aspects of 
printing, such as the page title, margins, page orientation, borders, date-time and page numbering, 
scaling, and much more. The page setup options can be saved to a file and loaded again later.

You can view the report before printing by using the Print Preview feature, accessible from the File menu, 
from the Print Preview button  on the main toolbar, or from the popup menu for the results table.

Printing the search results uses the current page setup options and can be performed in several ways: 



From the file menu, by clicking the Print button  on the main toolbar, by selecting Print from the popup 
menu for the results table, or by selecting Print from the Print Preview dialog.

See also:
Filtering Results
Sorting Results
Copying Results
Exporting Results



Viewing Domain Name Details
You can view domain name whois details by selecting Display Details from the popup menu for a selected
result (registered, unknown, and so on) in the search results table. If the Display Details option is not 
enabled then there is no information available, either because the search was cancelled for this result or 
the domain name database server returned no information.

When Display Details selected, the full domain name information obtained from the search is displayed in 
place of the results table.

To return to the results table select "Display Results" from the popup menu.

Note that the domain name details displayed are the details returned from the status search. These 
details may differ from those provided in the detail search as in some cases a different domain name 
database server or query is made to enhance the status search performance. Use the detail search to be 
sure that you are viewing the full details.

Note: Full domain name whois details might not be available for all domains.

See also:
Detail Search



Word Lists and Search Terms
You can save and load simple search, and advanced search word lists, pattern search terms, details 
search domain names and URL's entered in your searches. This feature is accessible through the File 
menu or the right-click popup menu for the search term.

Word lists allow you to keep lists of good product or service names or add-on words that you have 
developed.

TIP! Many word lists of common add-on words in the categories Internet, entertainment, general, 
adjectives, adverbs, interjections, nouns and verbs are provided with Domain Name Pro to get you
started. They are located in the folder in which Domain Name Pro was installed with the filename 
Words-Category.txt.

Word lists saved from the simple or advanced search also save the related settings, such as the number 
of thesaurus alternatives selected, and the position settings for the words in the word groups. These 
settings are restored when the wordlist is loaded. All invalid characters are stripped. Only a-z, 0-9, -, and 
spaces are retained.

When loading words into the simple or advanced search terms from other text files a maximum of 1000 
lines will be loaded. Only the first line in a text file will be loaded for a pattern.



Simple Search
The quickest way to start looking for domain names is to use the simple search. It can be as simple as 1, 
2, 3:

1. Select one or more domains to search (or select none to simply see the domain names that will 
be generated). 

2. Enter or load one or more search terms (words or character sequences separated by spaces or 
on separate lines, or even a full domain name - without the extension). 

3. Click the Search! button.

The simple search:

Domain Name Pro will search for combinations of domain names using the search terms that you 
entered. By default the domain names searched will use the following options:

· Up to three thesaurus alternatives for each word that you entered. 
· All entered words (or their alternatives) will be used in each domain name. 
· The approximate order of words entered will be kept (this option is only available if the Use all 

words option is selected). 
· Hyphens is disabled.
· Net Speak™ is disabled. 
· Acronyms is disabled. 
· Maximum length of 60 characters in the domain name. 
· Only the first 500 results will be displayed. 

These settings can be altered if required.

You can stop the search at any time. Once the search is finished you can click a domain name marked as
Available! (as a web hyperlink) to go to a domain name registration site to register it now, browse to the 
registered domain names displayed, or perform other actions from the context sensitive popup menu 
(right click).

A simple search is equivalent to performing an advanced search where each word is entered into a 
separate word group, with all word groups set to a position of Anywhere, all word groups set to Optional, 
and all word groups set to the same number of thesaurus alternatives. This means that all search terms 
entered will be checked in all possible combinations. This is sometimes not desirable, and therefore the 
simple search will sometimes display domain names that don't meet your requirements. You can simply 
ignore or filter these domain names from the results table, or use the advanced search for more control.

You can save and load the word list entered into the simple search term from the File menu or 
alternatively from the popup menu for the search term.



See also:
Domain Name Search Results Table
Advanced Search
Pattern Search
Detail Search



Advanced Search
Overview

The advanced search gives you ultimate control over how domain names are generated and checked. 
You can specify preferences that will limit the domain names to those that most closely match your 
criteria.

Word Groups

To perform an advanced search you use one or more word groups. A word group is a list of alternative 
words or domain name parts that should not be used together in the same domain name. For example, if 
you wanted to search for a domain name like "fresh food" or "tasty food" and you don't want domain 
names like "fresh tasty", simply place "fresh" and "tasty" in one word group and "food" in another.

Each word group has an individual setting for the valid positions of the words in the domain name, can be 
specified as optional or mandatory, and the number of thesaurus alternatives can be individually set. 
Word groups that have no words are ignored.

Word Group Positions

Typically, when searching for a domain name you don't want words randomly put together. Domain names
consisting of a verb or adjective and a noun, or two nouns are usually better in a particular order, such as 
"freshfood" instead of "foodfresh" or "tomatoseed" instead of "seedtomato". Word group positions allow 
you to restrict the position of words in the domain name.

Each word group can be set to one of the following specific positions within the domain name:

Start
Middle
End
Anywhere (default)
Start or Middle
Middle or End
Start or End

Note that a mandatory word group takes precedence over an optional word group in the same position.

Optional and Mandatory Word Groups

You can specify particular word groups to be optional or mandatory. This is often a requirement when 
choosing a domain name based on a particular list of subject or root words. This eliminates unnecessary 



domain names, and in doing so speeds up the search process and makes the results easier to read. 
Word groups are set to optional by default.

How to Perform an Advanced Search

The following steps are involved in performing a detailed advanced search:

1. Select one or more domains to search (or select none to simply see the domain names that will 
be generated). 

2. Enter or load a list of one or more words or terms in one or more word groups as required. 
3. Set the allowable position of each word group. 
4. Specify which word groups are optional and which are mandatory. 
5. Set the number of thesaurus alternatives for each word group. 
6. Change any of the general search options, such as use of hyphens, Net Speak™, acronyms, or 

limit the maximum number of words, maximum length, or maximum number of results. 
7. Click the Search! button. 

Domain Name Pro will search for combinations of domain names using the search terms and settings that
you specified. You can stop the search at any time. Once the search is finished you can click a domain 
name marked as Available! (as a web hyperlink) to go to a domain name registration service to register it 
now, browse to the registered domain names displayed, or select any option from the context sensitive 
popup menu (right click).

You can save the word lists entered into the word groups. The position, optional, and thesaurus 
alternatives settings for the word group are saved with the word list. You can save the settings for an 
individual word group or for all word groups together.

See also:
Domain Name Search Results Table
Simple Search
Pattern Search
Detail Search



Pattern Search
Overview

The pattern (character) search allows you to easily check combinations of domain names based on 
characters or word parts. Some examples of its use include checking all three character domain names, 
checking all four or five character pronounceable domain names, checking for all domain names that start
with a particular word and end in two digits, or check for domain names consisting of a specific 
combination of alternative and or optional characters or word fragments.

Patterns

Patterns involve using wildcard characters, optional parts, or alternate parts in the domain name.

A wildcard is a special character that denotes that all characters in a specific list should be used in the 
position of the wildcard character. Simply place one of the following wildcard characters anywhere in the 
pattern to have Domain Name Pro check the domain name with all possibilities:

X Any valid character (a-z, 0-9, '-')
Y Any valid alphanumeric character (a-z, 0-9, not '-')
A Any alphabetical character (a-z)
C Any consonant alphabetical character (b, c, d, f, ... z)
V Any vowel alphabetical character (a, e, i, o ,u)
N Any numeric character (0-9) 

Note that wildcard characters are in UPPER case to distinguish them from normal characters in the 
domain name.

Optional parts in the pattern are enclosed in parentheses ( ). The domain name generated will be tried 
both with and without the optional parts. Thus an optional "ing" in the domain name can be specified as 
(ing), and an optional wildcard of any character can be specified as (X).

Alternative parts in the pattern are enclosed in square brackets [ ] and separated by a forward slash /.

Example 1 The pattern [jump/walk/surf]([s/er/ed/ing]) would generate
domain names such as jump, walk, surf, jumps, jumper, 
jumped, jumping, walks, walker, and so on.

Example 2 The pattern search "CVCV" would generate the domain 
names baba, babe, babi, babo, babu, baca, bace, and so
on.

How to Perform a Pattern Search

The following steps are involved in performing a pattern search:

1. Select one or more domains to search (or select none to simply see the domain names that will 
be generated). 

2. Enter or load the search pattern, and use wildcards, alternative parts, or optional parts where 
appropriate. 

3. Change any of the general search options, such as use of hyphens, Net Speak™, acronyms or 
the maximum number of words, maximum length, or maximum number of results. 

4. Click the Search! button. 

An example pattern search:



Note that a large number of domain name combinations can easily be generated when using wildcard 
characters. Domain Name Pro will warn you if the potential number of combinations is high and give you 
the option to proceed. As Domain Name Pro generates and checks domain names dynamically there is 
no great risk in having a large number of combinations. You can limit the number of results or stop the 
search whenever you feel that enough domain names have been checked.

Note that all two and three character domain names in the .com domain are currently registered, as they 
are considered extremely valuable.

You can stop the search at any time. Once the search is finished you can click a domain name marked as
Available! (as an underlined web hyperlink) to go to a domain name registration site to register it now, 
browse to the registered domain names displayed, or perform other actions from the context sensitive 
popup menu (right click).

You can save and load patterns from the File menu or alternatively from the popup menu for the pattern 
term.

See also:
Domain Name Search Results Table
Simple Search
Advanced Search
Detail Search



Detail Search
The detail search allows you to quickly display the full domain name information for given domain names 
or URL's. A detail search involves the following steps:

1. If you want to search for the domain names in multiple domains then select one or more domains
to search from the domains list. 

2. Enter the domain name(s) with or without the domain extension, or URL's (full or partial, copied 
from your web browser for example). 

3. Click the Search! button. 

Domain Name Pro will display the full domain name information for each domain name. The information 
displayed varies for each domain and may contain one or more of the following:

· The status of the domain name (available or registered). 
· The registrant. 
· Date registered. 
· Name servers. 
· Date last updated. 
· Date it expires. 
· Technical contact information. 
· Administration contact information. 

To clear previous detail search results click the Clear Results button.

Example 1: You enter "internetshop" and select the .com and .org domains.
Domain Name Pro will display the domain name details for internetshop.com and internetshop.org.

Example 2: You enter "internetshop.co.uk" and "borland.com.au".
Domain Name Pro will display the domain name details for internetshop.co.uk and borland.com.au. 
Domain Name Pro ignores the domains selected in the domains list when you specify the domain in the 
name.

Example 3: You enter "http://www.internetshop.com/index.htm".
Domain Name Pro will display the domain name details for internetshop.com. Domain Name Pro extracts 
the domain name and domain from the URL and ignores the domains selected in the domains list.

You can list multiple and mixed domain names and URL's in the one query. Separate each with a space 
or place them on separate lines.

An example detail search:



TIP! Here's a simple way to get detailed information about similar domain names. Use the Simple, 
Advanced, or Pattern search with no domains selected. Enter your search term (e.g. for similar 
domain names on a particular topic) and click the Search button. This will instantly generate a list 
of domain names. Then:

1. Right-click the results table and select Copy, All Domain Names to copy the generated names 
to the clipboard.

2. Select the Detail Search. Right-click the search field and select Paste to insert the generated 
domain names.

3. Select the appropriate domain(s) in the domains list and click the Search button.
4. The full domain name information will be retrieved for all the domains generated.

Note: Full domain name whois details might not be available for all domains.

See also:
Simple Search
Advanced Search
Pattern Search
Viewing Domain Name Details



FAQ Overview
The Frequently Asked Questions section lists answers to common questions.

See also:
Do You Have Any Tips For Domain Names?
How Can I Use Words From a Text File?
What do the Unknown and Error Status Mean?
Can You Add Domain XYZ to the Domains List?
Are Pluralized Words in the Thesaurus and Popularity Database?
Can I Have More Than One Word in The Same Position?
Why is the Popularity Rating Shown as Zero?



Do You Have Any Tips For Domain Names?
Like any brand name, logo, or trademark, your domain name represents part of your business identity. 
Customers will associate it with your particular product, service, company or whatever you are using the 
domain name for, if you name it correctly. Remember that domain names will probably be used for several
purposes, including your web site, email address, and possibly an ftp or other server.
If your domain name can be easily remembered then you will attract more customers. People will use 
your web site or email address to get immediate and convenient access to the information or service that 
you are providing.

Domain names are portable. You can move address, change phone numbers, change Internet service 
providers, change the company that hosts your web site, and still keep the same domain name. This 
provides an extremely flexible method of keeping in touch with your customers and users.

Here is a list of tips for choosing good domain names:

· DO know the domain name format. Domain names can generally be between 2 and 67 
characters long (including the extension), and contain the characters a-z, 0-9 and '-' (hyphen). 
Some domains have a minimum length of 1 character and others require at least 3 characters. 
Domain names cannot start or end with '-' (hyphen). Domain names are not case sensitive, 
though it is often useful to display them in advertising with capitalized words. e.g. 
www.ShoppingForTheWorld.com. You can now also register multi-lingual domain names. 

· DO know your target audience. Choose domain names that are appropriate for them. Depending 
on who you are targeting this could mean choosing names that sound sincere, cool, current, 
active, professional, or that use key words from the industry for example. 

· DO keep domain names short and simple. Generally, the shorter the domain name the easier it is 
to remember or write down, and the less chance of users noting and remembering it incorrectly. 
Restrict the domain name to one, two or three words at most. (The one exception to this is the 
next tip). All other things being equal, give preference to words with fewer syllables and words 
that are easy to pronounce. Short is good, but don't use difficult to remember acronyms, such as 
qmxf. 

· DO register a long domain name containing a list of relevant words for your web site to achieve a 
higher ranking in some search engines. It is generally better to separate the words with hyphens 
in this case. Several of the major search engines rank web sites much higher if the search terms 
are contained in the domain name. You can use up to 63 characters to create a long domain 
name with keywords and automatically redirect visitors to the real web site. Some registrars offer 
the redirect service as standard in their price. 

· DO use the appropriate pluralization. For example, newhomes.com is probably better than 
newhome.com if the web site is not relating to "a" particular home. 

· DO use words that can be "visualized". Use words that involve several of the 5 senses (sight, 
smell, hearing, touch, taste). This usually involves choosing more common nouns (names or 
objects), verbs (actions), and adjectives (descriptions). For example, the word "fire" is easily 
imagined. It includes strong cues in four of the five senses - sight (red and yellow flames), hearing
(crackling and other noises), touch (heat), and smell (smoke). 

· DO plan for the future. If you are planning on releasing other products or services from this 
domain name in the future then don't limit the relevance to the initial product or service. That 
being said Internet marketing experts believe that your web site should have only one subject or 
focus. All products or services listed on the web site should be related. A web site with a broad 
focus is not as appealing to someone who is looking for particular information. 

· DO use all features of Domain Name Pro to create your domain names. Learn and use the 
advanced search, and set specific options for each word group that you use. By using the 
thesaurus alternatives, Net Speak™, and acronyms options, Domain Name Pro can find domain 
names that you may not have thought of. For specific domain names based on an existing 
product, service, company or other name, use the pattern search in Domain Name Pro to check 
name variations. 

· DO register the domain name in the correct global or country level domain. For universal appeal 
use a .com, .org, or .net domain. For local appeal use an appropriate domain in your country, 



such as .co.uk or .org.au. Note that many domains have restrictions on what domain names can 
be registered. In some domains you can only use a name that is derived from a registered 
business or organization name. 

· DO check that you are not infringing on an existing trademark or other name that rightfully 
belongs to another company or individual. An available domain name does not necessarily give 
you the right to register and use it. 

· DON'T use hyphens between words if possible. A domain name with hyphens is harder to 
describe when said aloud. It is commonly accepted that a domain name with multiple words does 
not include hyphens. An exception to this rule is when choosing a domain name that has many 
words or words that are hard to decipher. 

· DON'T use confusing spelling. If your domain is targeted at a worldwide audience then stay away
from words that are spelt differently throughout the world, such as words ending in 
ize(US)/ise(UK). This also applies to many words that have different meanings throughout the 
world. Some common English words are even offensive in other languages. 

· DON'T choose domain names that are very similar to others if possible. After all, you want 
customers coming to you, not your competitors! An exception to this rule is if you register the 
domain name of a commonly misspelt word, in the hope of catching additional customers. 

· DON'T choose domain names with words that join to form unintentional words such as "jeans 
wearing" which can read "jean swearing". Avoid them altogether or use hyphens to separate the 
words if really necessary. Another way to avoid this is to use capitalization of words in the domain 
name in all advertising. e.g. www.JeansWearing.com

You can also register multiple domain names in many domains, and have them directed to the same web 
site or a sub-part of your web site. 

Good luck!

See also:
Overview



How Can I Use Words From a Text File?
Domain Name Pro can read words from a simple text file. The words should be separated by spaces or 
alternatively one word per line.

There are two ways to load word lists. Either:

· Right-click the search field in the simple or advanced search and select Load from the popup menu. 
· Select Load from the File menu and choose the search field that you would like the words loaded into.

Next, browse to the word list file and click the Load button. Note that any current text that you have in the 
search term will be replaced by the loaded word list. To search only for each single word in the list (and 
not combinations of multiple words) set Max. Words to 1.

The maximum number of lines that will be read from a file is 1000.

See also:
Word Lists and Search Terms



What do the Unknown and Error Status Mean?
An "unknown" status is displayed when information is returned by the domain name database server but it
does not indicate whether the domain name is available or registered. One cause for this is with certain 
domains, such as .ac, and .sh where the domain name database server limits the number of queries that 
can be made in a given period of time, resulting in a "too many queries" type response code.

An "error" status is displayed when information is not returned by the domain name database server. This 
usually occurs when there is a problem with your Internet connection or Internet service provider. Check 
that your Internet connection is working normally. A simple way to do this is to use your web browser to 
browse to a couple of local and international web pages, preferably web pages that you haven't recently 
visited. If the web pages display correctly then you Internet connection is probably ok. Another cause for 
errors is the domain name database server itself. Domain Name Pro searches different servers for each 
domain, and it is possible for the server to be temporarily unavailable. If you are having trouble with most 
or all domains and you are using a firewall then you will need to allow Domain Name Pro to connect to 
external hosts on TCP port 43. See your network administrator for details.

If either of these status codes persist then please contact us, stating the search that you performed and 
the domain that always lists the status as unknown or error.

See also:
Domain Name Search Results Table



Can You Add Domain XYZ to the Domains List?
If there is an accessible domain name database server for that domain then yes. Please contact us with 
the domain details. We will endeavour to find the server for the domain and if available we will add the 
domain to the domain list and make the new list available as a free update for all users.

See also:
Selecting Domains



Are Pluralized Words in the Thesaurus or Popularity Database?
The thesaurus used in Domain Name Pro is a condensed version of Roget's thesaurus for commonly 
used words in order to keep it to a reasonable size. It contains up to 10 alternatives (usually 10) for more 
than 11,000 words. In general this thesaurus does not contain pluralized nouns.

The search term popularity database in Domain Name Pro is derived from a major search engine 
provider. This database treats both singular and plural words as the same word and the database 
therefore only contails singular words (with a few exceptions). This has two implications:

1. The search popularity rating for both a singular and plural word is the same.
2. Only terms with singular words are generated as popular alternative domain names.

You must decide if the particular domain name should contain singular or plural words. For example, is 
homeloans.com better than homeloan.com? Use the search term popularity rating as a guide when 
deciding upon domain names.

We are investigating several possibilities of adding pluralized words to the thesaurus and popular terms 
databases. If a solution is feasible then it will be added to an upcoming version.

See also:
Using Thesaurus Alternatives



Can I Have More Than One Word in The Same Position?
Yes. Word groups can use the exact same position, such as Start/End used twice, or overlapping 
positions, such as Start/Middle for one group and Middle/End for another. The mandatory/optional setting 
will have an impact on how the word groups will be used. For example, if you set one word group as 
position End and make it mandatory, and another word group as position End and make it optional, then 
words from the second group will be ignored, as to satisfy the mandatory setting of the first group means 
that the End position is already taken.

See also:
Advanced Search



Why is the Popularity Rating Sometimes Zero?
A database of the frequency of 100,000 search engine search terms is used to calculate the popularity 
rating. A rating of zero means that the search term is not in the database. This is usually because either 
the search term is very common (such as "the" or "and", which are ignored by the major search engines) 
or uncommon.

Upgrade Note: The latest version of Domain Name Pro contains a database of 500,000 terms. This 
procudes much more relevant search popularity ratings. Upgrade Domain Name Pro.

See also:
Popularity Rating



Upgrading
Upgrading

Special Upgrade Offer!

The latest version of Mozzle Domain Name Pro contains many great new features not found in the 
Practical Internet Web Designer edition. These include:

· Website link popularity search in 9 major search engines and Yahoo and DMOZ directories.
· Word terms search to find popular keywords and domain names.
· Domain name website competition ratings.
· Domain name effectiveness index (TM) to rate domain name value.
· Automatic popular alternative domain names.
· An additional 400,000 terms in the search term popularity database.
· Display the type of domain name generated in searches.
· Pause and resume searches.
· Multiple domain name display formats.
· Play a sound when a search is finished.
· Generate and search up to 20,000 domain names.
· Color-coded domains list.
· and more!

Save 40% off the normal price!

To upgrade Domain Name Pro:

Select Upgrade Now from the Upgrade menu in Domain Name Pro. You will need the special 
promotional code printed in the magazine to take advantage of the special upgrade offer.



Contact Us
Support 
Please follow these steps for support:

· Read the Frequently Asked Questions section for a solution to your problem.
· Check for additional answers to questions in the online FAQ on the Mozzle web site.
· Ensure that you are running the latest version of Domain Name Pro. Select Check For Updates from 

the Help menu and download and install any updates that are available.

Contacting Support

· Select Support from the Links menu of Domain Name Pro.

Please provide the following details with your support query:

· The Edition name from the Domain Name Pro splash screen or window title.
· The version numbers displayed on the Help, About dialog (program, domains list, and link popularity 

list).
· Which version of the Windows operating system that you are using.
· The symptoms (including a screen shot if possible - that always helps).
· Your full name and email address.

Support requests will be dealt with as soon as possible. We will notify you when your support enquiry is 
received and provide an approximate timeframe in which we will respond in full.

General Product Information
For general product information and enquiries please send an email to us:

· Select Info Email from the Links menu in Mozzle.

Feedback, Complaints, or Other Questions
Complaints will be dealt with as soon as possible. We will notify you when your complaint is received and 
provide an approximate timeframe in which we will respond in full. Please provide as much detail as 
possible.

Email: general@mozzle.com 

Address

Backslash
79 Langhorne Crescent
Rowville      VIC      3178
Australia 



Phone
Backslash is located on the east coast of Australia. Due to timezone differences around the world we 
prefer email contact. Please use one of the previously listed methods to email us. 

Fax 
Wordwide: +61-3-8610-1654
Within Australia: 03-8610-1654




